
What does SpaceMan 98 do?

SpaceMan 98 is an application that can help you find out which files and folders are using up
most of your disk space.    It also contains facilities to help find files that can be deleted to 
make more space available.    It performs two main functions.

Finding disk space used by folders
SpaceMan 98 can show an overview of all folders, and give the total amount of disk space 
used by all the files within each one.    This can be used to find out which folders are using 
the most disk space.

Finding duplicate files
SpaceMan 98 can also find files that have identical copies elsewhere on the system.    
Unnecessary copies can then be deleted to free up space on the disk.    SpaceMan 98 finds 
identical copies by performing a complete byte for byte comparison, so you can be sure that
any duplicate files found by SpaceMan 98, really are identical.



System requirements

SpaceMan 98 requires:
Windows 95, or later, or
Windows NT 4.0, or later.

2 Mbytes disk space.



Quick tour of SpaceMan 98

SpaceMan 98 works in a similar way to the Windows Explorer application, except that it has 
two extra panels at the bottom that are used for showing duplicate files.

The top left panel contains the folder browser, a hierarchical view of all the folders on the 
system.    Each folder can be expanded or collapsed by clicking on the + or - symbol next to 
the folder name.    When a folder and all its subfolders have been scanned for disk space, the
disk space is shown to the left of the folder’s name in square brackets.

The top right panel contains the file browser, which shows the folders and files in the 
currently selected folder.    When a file has been scanned to test for duplicates, a symbol will 
appear to the left of its name, to show whether it is a duplicate or not.    When all the files in 
a folder have been scanned to test for duplicates, the unique-file symbol will appear next to 
that folder’s name.

The bottom left panel shows the duplicates list.    When two (or more) files are found which 
are exact copies of each other, a line is added to this list which shows the names of the 
duplicate files, and the size of the files.

The bottom right panel shows the duplicate files in the duplicates set that is currently 
selected in the bottom left panel.

Resizing the panels

The sizes of each of these panels can be changed by moving the bars that run between 
them.    There is a single bar running horizontally that separates the folder and file browsers 



from the duplicates list and the duplicate files browsers.    This can be dragged up or down.    
There are two vertical bars that can be dragged independently.    One separates the folder 
browser from the file browser, and the other separates the duplicates list browser from the 
duplicate files browser.



Folder browser

The folder browser panel is used to:
    Browse through all the folders on the system.
    Show the total disk space used by all files in a folder.
    Select a folder for scanning.
    Select a folder for viewing in the file list panel.
    Select a folder for use by the delete duplicates panel.

To scan a folder, select the folder name with the left mouse button.    When a folder is 
selected for scanning, it’s name in the browser will be preceded by empty square brackets `[
]`.    Once it has been scanned, including all subfolders under it, the total amount of disk 
space used by all files under the folder will be shown in the square brackets.

If scanning for duplicates is also enabled, then any duplicate files found in the folders that 
are scanned will be shown in the duplicates list panel.    

The currently selected folder is shown in the file list panel.    To select a folder without 
scanning it:
    Hold down the control key while selecting the folder, or
    Select the folder with the right mouse button (this will also bring up the context sensitive 

menu).

To expand a folder to show subfolders:
    Click on the + icon next to the folder name, or
    Double click on the folder name.

To contract a folder to hide its contents:
    Click on the - icon next to the folder name, or
    Double click on the folder name.

Right clicking on a folder brings up the folder context menu.



File browser

The file browser shows the contents of the folder currently selected in the folder browser.

For each item in the folder, the following information is listed:
    Name
    Disk space used
    File size, or total size of all contained files for folders
    Modification time

Once a folder has been scanned for duplicates, the file browser also shows whether each file
is unique, or if there is another copy of the file.    This is shown by one of the following 
symbols next to the name:

    File is unique
    There is another copy of this file

The  symbol is also shown next to folders to indicate that all the files in that folder (but not
necessarily all of its subfolders) have been scanned.

When a file is shown to be a duplicate, the other copies of that file can be found by selecting
the file.    The other copies of the file will then be shown in the duplicate files browser.

Right clicking on a folder brings up the folder context menu, and right clicking on a file 
brings up the file context menu.    Multiple folders or files can be selected by holding down 
SHIFT while selecting to extend the selection, or CTRL to toggle the selection status of the 
item picked.

The file list can be sorted by name, disk space, file size or modification time.    By default it is
sorted by file size.    To change this, click in the title box of the column you want to sort by.    
If you click a second time in the same title box, the sort order is reversed.



Duplicates list browser

The duplicates list browser shows the duplicate files that have been found.    Each line in the 
list shows one set of files that are all identical copies of each other.    The information shown 
for each set of identical files is:
    File names.    If two or more files have the same name, the name is only shown once.
    File size.    All files must be the same size since they are exact copies of each other.
    The number of duplicate files.

To see the full paths to each of the files in a duplicates set, select the line.    The duplicate 
files browser will then show the path for each file.

Right clicking on a duplicates set brings up the file context menu. Selecting one of the 
commands in this menu will cause the command to be applied to each of the files in the 
duplicates set.

The duplicates list can be sorted by name, size or number of duplicates.    By default, it is 
sorted by size.    To change this, click in the title box of the column you want to sort by.    If 
you click a second time in the same title box, the sort order is reversed.

If the duplicates list browser is shown grayed out, it means that scanning for duplicates has 
been disabled.    It can be re-enabled either by pressing the  button on the toolbar, or by 
choosing the File/Scan Size Only menu command.



Duplicate files browser

The duplicate files browser shows each of the files that are in the currently selected 
duplicates set in the duplicates list browser.    The files shown in the duplicate files browser 
are always identical copies of each other.

Selecting a file in the duplicate files browser causes the folder browser to be expanded to 
show the folder in which the file exists.    The file is also selected in the file browser.

Right clicking on a file brings up the file context menu.

If the duplicate files browser is shown grayed out, it means that scanning for duplicates has 
been disabled.    It can be re-enabled either by pressing the  button on the toolbar, or by 
choosing the File/Scan Size Only menu command.



Folder context menu

The folder context menu is brought up by right clicking on a folder in the folder browser or 
file browser.    It contains the following commands:

Explore
Launches Windows Explorer, expanded to show the selected folder.

Delete
Deletes the selected folder and all subfolders under it.    For more information, see the delete
command.

Delete Duplicates
Brings up the delete duplicates panel for the selected folder.

Clear Folder Data
Clears all the size and duplicates information that has been found for the selected folder, 
and for all subfolders under it.    This command is similar to the File/Reset menu command, 
except that it only clears information about the selected folder.    This command can be 
useful to exclude certain folders that contain duplicate files that you want to ignore, or to 
rescan folders that contain files which have been changed, added or removed by other 
applications.



File context menu

The file context menu is brought up by right clicking on a file.    It contains the following 
commands:

Open
If the file is an executable, it is run.    Otherwise, the file will be opened in the appropriate 
application for the type of file.

Delete
Deletes the selected file or files.    For more information, see the delete command.



Finding disk space used by folders

To find the total disk space used by all the files in a folder, and in all subfolders under it, 
simply select the folder in the folder browser with the left mouse button.    For example, to 
find the sizes of all folders on the C: drive, simply select the C: folder in the folder browser.    
For more information on selecting folders for scanning, follow this link.

The total disk space used by all files in a folder (and all subfolders) is shown in square 
brackets next to the folder name.    If the square brackets next to a folder name are empty, it
means the size for that folder is still being calculated.

By default, selected folders are also scanned for duplicate files.    If you only want to find 
folder sizes, it will be much quicker if you disable scanning for duplicates before selecting 
the folder to scan.    This can be done either by pressing the  button on the toolbar, or by 
choosing the File/Scan Size Only menu command.



Finding duplicate files

To find duplicate files, simply select the folder you want to scan in the folder browser with 
the left mouse button.    For example, to find all the duplicate files on the C: drive, simply 
select the C: folder in the folder browser.    For more information on selecting folders for 
scanning, follow this link.

All duplicates found will be listed in the duplicates list browser.

Note that duplicate files can only be found if all the folders containing the copies of a file are
scanned.    For example, if there is a file in C:\Folder1 that has an exact copy in C:\Folder2, 
then if only C:\Folder1 is scanned, the file will be shown as unique.    Only when C:\Folder2 is 
scanned as well will the duplication be found.

If you have disabled scanning for duplicates, it must be re-enabled before you select the 
folder for scanning.    This can be done either by pressing the  button on the toolbar, or by 
choosing the File/Scan Size Only menu command.

Problems that can occur when scanning for duplicates
You may find that sometimes when you select a folder for scanning, some files within it do 
not get scanned.    This can be due to one of the following reasons:
    The file is already open in another application.    Close all other applications and try again.
    You do not have read access for the file.    Check the permissions and ownership of the 

file.
    The file is empty.



Controlling the folders that are scanned

If you don’t want to scan all folders on a drive, you can browse to the folder you want to 
scan and just select that one.    However, if you simply double click on a folder to expand it, 
this will also begin scanning that folder.    To avoid this, either expand folders by selecting the
+ next to the folder name, or hold down the CTRL key while double clicking on the folder.    
The CTRL modifier allows a folder to be selected without being scanned.

More folders can be selected for scanning before the first has been finished.    The folder 
currently being scanned is shown in the status bar.    When several folders have been 
selected for scanning, SpaceMan 98 gives priority to the currently selected folder.    Once the
currently selected folder (and all subfolders under it) has been scanned, SpaceMan 98 will 
scan all the remaining folders that were selected.

At any time, scanning can be aborted by pressing the stop button.

Rescanning folders

If any files are changed, added or removed by another application, then if SpaceMan 98 has 
already scanned the affected folders, the information gathered by SpaceMan 98 has to be 
cleared so that the folder will be scanned again.    The easiest way to do this is to use the 
Reset Data command.    This clears all information gathered by SpaceMan 98.    Alternatively, 
just particular folders can be rescanned by using the Clear Folder Data command.



Deleting files

Any file or folder can be deleted by simply selecting it, and choosing the delete command.

You should always take great care when deleting files, as you can lose work or stop 
something from working if you delete the wrong file.    The best rule is, if you don’t know 
what a file is, then don’t delete it.    By default, SpaceMan 98 protects most files used by the 
Windows operating system.    To turn this protection off, use the options panel.

Also, see these notes on deleting applications from your system.

Deleting duplicate files

SpaceMan 98 has a special purpose command built in to help delete duplicate files. This 
provides a safe way to delete files and be sure you still have at least one other copy of any 
file deleted.

Note, however, that just because a file is a duplicate, this does not always mean it can be 
safely deleted.    For example, an application may install a copy of a file that already exists 
on the system, but if the application only looks for the file in the new location, it will fail if 
the new copy of the file is deleted.



Delete duplicates panel

To bring up the delete duplicates panel, select a folder in the folder browser, and then use 
the delete duplicates command.

The delete duplicates panel provides a way to delete duplicate files, but makes sure that all 
copies of a file can not be deleted.

It does this by looking for files that have at least one copy inside the selected folder (or any 
subfolder), and another copy outside.    Two options are then offered: delete all the files 
outside the selected folder that have copies inside, or delete all the files inside the selected 
folder that have copies outside.

Here are typical scenarios when you would use each option:

Deleting copies outside the selected folder
This option allows you to clean up your system so that any copies of a file are in a 
known folder.    If you have some files that you may have several copies of in different
places, you can choose one folder where you want these files to be stored.    After 
putting one copy of these files in the chosen folder, you can use the delete duplicates
command to delete any other copies of these files anywhere else on your system (or 
at least, in any other folders you have scanned).

Deleting copies inside the selected folder
This option is used when deleting folders that contain duplicate files.    Instead of 
deleting the folder by using the delete command, you can delete the files in it using 
the delete duplicates panel.    You can then be sure that every file deleted from inside 
the folder has another copy somewhere else on your system.

When the delete duplicates command is selected, the first thing that happens is that all files 
in the selected folder are checked to see if any are duplicates.    If the selected folder has not
been scanned for duplicates and nor have any subfolders under it, or if no duplicate files are 
found, then a message box is shown.    Otherwise the delete duplicates panel appears.    If 
the list of files shown in the delete duplicates panel is empty, then all the duplicate files 
found in the selected folder only have copies which are also inside the selected folder.

If the option to protect Windows operating system files is enabled, then any files in the 
protected folder, or any subfolders under it, will not be shown in the list of files to be delete.  
This can be another reason why the list of files to delete may be empty.

The list inside the panel shows the files that will be deleted if the Delete button is pressed.   
The list changes when the switch is changed to choose between deleting copies inside or 
deleting copies outside the selected folder.

Note that when the delete duplicates panel is brought up, it does not perform any new 
scanning of files.    You should make sure that all folders that you want to check for 
duplicates have already been scanned before bringing up the delete duplicates panel.    For 
more information on scanning for duplicate files, follow this link.



Options panel

To bring up the options panel, use the view options command.

The options panel allows you to change whether the Windows operating system files are 
protected from deletion.    If this option is enabled, then you will be unable to delete any files
in the Windows folder from within SpaceMan 98.    

The protected folder is shown.    This is fixed by the operating system and can not be 
changed.



Deleting files safely

You need to take great care when deleting files, since deleting the wrong file can cause an 
application, or even the whole system, to stop working.    SpaceMan 98 has an option to 
protect the Windows operating system files, which it is recommended you leave enabled.    
This prevents any files in the Windows folder from being deleted.    If you do need to delete a
file in this folder, and you are sure that you know what you are doing, use the options panel 
to disable the protection.

The best rule is: if you don’t know what a file is for, don’t delete it!

The recycle bin can give you a second chance if you accidentally delete the wrong file.    By 
default, SpaceMan 98 will send deleted files to the recycle bin, from where they can be 
retrieved.    This does mean that the disk space used by deleted files is not recovered 
immediately, so you will need to periodically empty the recycle bin.    For more information 
about the recycle bin, see the delete command.

For recommendations on removing whole applications from your system, follow this link.



Deleting applications

An application should not be removed by simply deleting the folder into which it was 
installed.    This is because an application often stores files in other folders as well as the one
into which it was installed.    Applications may also make entries into the system registry that
should also be deleted when the application is removed.

The correct way to remove an application is to un-install it.    This is done from the 
Add/Remove Programs panel, as follows:
    From the Windows Start menu, choose Settings, then Control Panel.
    From the Control Panel, double click on Add/Remove Programs.
    The Add/Remove Programs panel shows a list of all the applications installed on the 

system.    Select the application you want to remove, then click the Add/Remove button.

If the application is not listed in the Add/Remove Programs panel, then it may be that it has 
a standalone un-install program.    Look in the Windows Start menu to see if the application 
has an entry that contains an un-install program. 

If you can not find an un-install program for the application, then you have no choice but to 
remove it manually, by deleting the folder into which the application was installed.    
However, only remove it this way as a last resort.



Using built-in Windows commands

This section briefly describes how to use the Windows Find command, which can be very 
useful for disk management.

SpaceMan 98 helps find the largest folders on a disk.    If you just want to know where the 
largest files are, then you can do this as follows:

How to find the largest files on a disk
    From the Windows Start menu, select Find, then Files or Folders.
    Choose the disk(s) you want to search in the Look In selector.
    Select the Advanced tab, and select Size is At least, 1000 KB.    Strictly speaking this step 

is not necessary, but it filters out small files of less than about 1 MB.
    Press the Find Now button.
    You will then get a list of all files that match the criteria specified.    To find the largest 

files, click on the Size column header, which will sort the files by size.    The largest file will 
then be first in the list.
    You can make the Find panel bigger by dragging out either of the bottom corners, or by 

pressing the maximize button in the title bar.

Useful articles in Windows Help.
There are also some useful hints and tips in the Windows Help system.
    From the Windows Start menu, select Help.
    Double click on Troubleshooting
    Double click on If you need more disk space



How to buy

To register SpaceMan 98 costs just $15.    You can order by any of the following methods 
using one of these credit cards: MC, Visa, Amex, or Discover.

Online: Go to our Web site at http://www.extrabit.com and click on "Order Online". 
{button Open Web Page Now,EF(`www.extrabit.com/index.htm',`',1)}

To order by fax, email or mail, use the form in order.txt.
{button Open Order Form Now,EF(`order.txt',`',1)}

FAX: To 713-524-6398.    Use the form in order.txt.      The easiest way is to fill out the form 
and fax it directly from your computer.    If you can’t do that, then fill it out and print the 
form.    If you can’t print the form and you copy it out by hand, then please write in plain 
block print, and make sure you include the product number 15633.

Email: To PSL at "15633@pslweb.com".    Fill out the form in order.txt, then copy and 
paste the contents into an email message.

Mail: check or credit card orders to PSL at P.O.Box 35705, Houston, TX 77235-5705.      
Fill out the form in order.txt, then print it out and send it to this address. If you can’t print 
the form and you copy it out by hand, then please write in plain block print, and make sure 
you include the product number 15633.    If you are sending a check, you do not need to fill 
out the section of the form that deals with credit cards.      Checks must be in US$, and drawn
on a US bank, and should be made payable to "PSL".

Phone: PSL's operators are available from 8:30 a.m. to 5:30 p.m. CST
Monday-Friday at 800-242-4775 Ext.15633 or at 713-524-6394 Ext.15633

THE ABOVE NUMBERS ARE FOR CREDIT CARD ORDERS ONLY.
THE AUTHOR OF THIS PROGRAM CANNOT BE REACHED AT THESE NUMBERS. 

Any questions about product details, technical support, dealer pricing, site licenses etc. must
be directed to "info@extrabit.com". 

Quantity discounts

If you order more than 1 license at the same time, you qualify for the following quantity 
discounts:

1st license $15
2nd - 9th licenses $10 each
10th and above license $5 each

The following table shows how this works:

No. of licenses Total cost
1 $15
2 $25
3 $35
4 $45
5 $55
6 $65
7 $75
8 $85



9 $95
10 $100
More than 10 Add $5 for each additional 

license

When you order SpaceMan 98, you will receive a registration code that you will need to 
enter into the registration panel.    The registration code will also work with any future 
versions of SpaceMan 98.    You can check on the Internet site www.extrabit.com to find 
the latest version.



END-USER LICENSE AGREEMENT FOR SPACEMAN 98

License Agreement

You should carefully read the following terms and conditions before using this software.    
Your use of this software indicates your acceptance of this license agreement and warranty.

Evaluation and Registration

This is not free software.    Subject to the terms below, you are hereby licensed to use this 
software for evaluation purposes without charge for a period of 30 days.    If you use this 
software after the 30 day evaluation period a registration fee of $15 is required.    The 
software can be ordered as described in the section "How to buy".    When payment has been
received you will be given a registration code that can be used to register your copy of 
SpaceMan 98.

Distribution

You may make as many copies of this software and documentation as you wish.    You may 
freely distribute this software by any means provided that you include all files in the original 
distribution.

You are expressly forbidden from distributing by any means the registration code.

Registered Version

One registered copy of SpaceMan 98 may either be used by a single person who uses the 
software personally on one or more computers, or installed on a single workstation used 
non-simultaneously by multiple people, but not both.

You may access the registered version of SpaceMan 98 through a network provided that you 
have obtained individual licenses for the software covering all workstations that will access 
the software through the network.    For instance, if ten different workstations will access 
SpaceMan 98 on the network, each workstation must have its own SpaceMan 98 license 
regardless of whether they use SpaceMan 98 at different times or concurrently.

Governing Law

This agreement shall be governed by the laws of England.

Disclaimer of Warranty

THIS SOFTWARE AND THE ACCOMPANYING FILES ARE SOLD "AS IS" AND WITHOUT 
WARRANTIES AS TO PERFORMANCE OR MERCHANTABILITY OR ANY OTHER WARRANTIES 
WHETHER EXPRESSED OR IMPLIED. ANY LIABILITY OF THE SELLER WILL BE LIMITED 
EXCLUSIVELY TO PRODUCT REPLACEMENT OR REFUND OF PURCHASE PRICE.

SpaceMan 98 Copyright © 1998 by Mark Williams. All rights reserved.



Reset Data command (File menu)

Clears all the folder-size information and duplicate file data already gathered.    This may be 
useful if lots of files have been changed, added or removed by other applications, and you 
want to rescan all the folders already scanned.

Shortcut
Keys: ALT, F, R



Show Sizes in Bytes command (View menu)

All sizes will be shown in bytes.



Show Sizes in Kilobytes command (View menu)

All sizes will be shown in kilobytes (1 kilobyte = 1024 bytes).    If the size is not a whole 
number of kilobytes, it will be rounded up.



Show Sizes in Megabytes command (View menu)

All sizes will be shown in megabytes (1 megabyte = 1024 kilobytes = 1,048,576 bytes).    If 
the size is not a whole number of megabytes, it will be rounded up.



Show Sizes in Gigabytes command (View menu)

All sizes will be shown in gigabytes (1 gigabyte = 1024 megabytes = 1,073,741,824 bytes).   
If the size is not a whole number of gigabytes, it will be rounded up.



Show Sizes in Automatic Units command (View menu)

Sizes will be shown in different units, depending on the value.    The following table shows 
which units will be used for different sizes:

Size in bytes Units used Shown as
0 - 1,023 Bytes
1,024 - 1,048,575 Kilobytes KB
1,048,576 - 
1,073,741,823

Megabytes MB

1,073,741,824 or 
greater

Gigabytes GB

Stop command (File menu)

This command stops any scanning currently in progress.    Any information already gathered 
will be kept.

Shortcut
Key: ESC



Enable Scanning for Duplicates command

This command enables scanning for duplicates, if it has been disabled.    Scanning for 
duplicates can be slow, so if you only want to find folder sizes, then it is best to disable 
scanning for duplicates.

Shortcut
Keys: ALT, F, S To toggle between enable/disable



Disable Scanning for Duplicates command

This command disables scanning for duplicates. Scanning for duplicates can be slow, so if 
you only want to find folder sizes, then it is best to disable scanning for duplicates.

Shortcut
Keys: ALT, F, S To toggle between enable/disable



Enable/Disable Scanning for Duplicates command (File menu)

When this menu item is checked, scanning for duplicates is disabled.    Select again to re-
enable. Scanning for duplicates can be slow, so if you only want to find folder sizes, then it is
best to disable scanning for duplicates.

Shortcut
Keys: ALT, F, S



Delete Duplicates command (File menu)

This command brings up a dialog box that allows you to delete duplicate files.    If any 
scanning is in progress, it is stopped when you bring up the delete duplicates dialog.

Shortcut
Keys: ALT, F, D

See: Delete Duplicates Dialog.



Delete command (File menu)

This command deletes the currently selected folders or files.    The currently selected folders 
or files are those which are selected in the active panel of the main window.    The active 
panel is the one that has the selection highlighted.

When the duplicates list is the active panel, the selected files will be all the duplicate files at 
the selected line.    If this is deleted, then all the duplicate files on the selected line will be 
deleted, leaving no copies of these files.

When files or folders are deleted, they are moved to the recycle bin on your Windows 
desktop, unless the recycle bin option has been set to permanently delete files immediately. 

To change the recycle bin options, right click on the recycle bin icon on the desktop, and 
choose Properties from the menu that pops up.

To permanently delete files that have been moved to the recycle bin, right click on the 
recycle bin icon on the desktop, and choose Empty Recycle Bin from the menu that pops 
up.

Shortcut
Key: DEL



View Options command (View menu)

This command brings up the dialog box that allows you to change configuration preferences 
for SpaceMan 98.

Shortcut
Keys: ALT, V, O

See: Options Panel



Help command (Help menu)

Opens the help window, showing the contents.

To get context sensitive help on the currently selected object, press F1.

Shortcut
Keys: ALT, H, H



This is the currently selected folder in the Folder Browser.    To change this, press the Cancel 
button, select a different folder in the Folder Browser, then bring up the Delete Duplicates 
panel again.



When this option is selected, the files selected for deletion will be those in the selected 
folder which have a copy outside the selected folder.    (Note: the selected folder also 
includes all subfolders under it).    This option is useful if you want to clear out a folder and 
be sure that any file deleted from inside the folder has a copy somewhere else.



When this option is selected, the files selected for deletion will be those outside the selected
folder that have a copy in the selected folder.    (Note: the selected folder also includes all 
subfolders under it).    This option is useful if you want to make sure that any copies of files 
exist only in the selected folder.



This area shows the list of files that will be deleted if the Delete button is pressed.    To 
change the width of the file names or paths column, drag the right edge of either column 
title box.    If this list is empty, it means that there are no files in the selected folder that have
an identical copy outside the selected folder.



Pressing this button closes the panel without deleting any files.



Pressing this button deletes the files listed.



Registration dialog box

To bring up the registration dialog box, go to the Help menu, then select About SpaceMan 
98.    This brings up the About box.    If you are running an unregistered version of SpaceMan 
98, then this panel will have a Register button on it to bring up the registration dialog box.

When you order SpaceMan 98, you will be given a registration code.    Once you have 
entered this code into the registration dialog box, your copy of SpaceMan 98 will be 
registered.



Welcome to SpaceMan 98

The code you have entered has been verified, so your version of SpaceMan 98 is now 
registered.    This means that none of the panels referring to the evaluation period will 
appear from now on.

We hope you continue to find SpaceMan 98 to be a valuable tool.

Thank you for registering SpaceMan 98.



Incorrect code

The code you have entered is invalid.    Check that you have entered the code exactly as 
given.

If you do not have a registration code, you can get one by ordering SpaceMan 98.



No duplicates found

The currently selected folder does not contain any duplicate files.    Therefore, there are no 
files in this folder that can be deleted from the delete duplicates panel.



Not scanned for duplicates

The currently selected folder has not been scanned for duplicates yet.    Make sure that 
scanning for duplicates is enabled, and then select the current folder again with the left 
mouse button.

You will also need to have scanned at least one other folder for duplicates.    This is because 
the delete duplicates panel can only delete duplicates where one copy is inside the selected 
folder, and another copy is outside.

See: Delete duplicate panel.



No application registered for this type of file

No applications are registered for the type of file you are trying to open.    The file is probably
used internally by an application and is not meant to be opened, or you do not have the 
application that is needed to open it.

The type of a file is determined from its extension (the part of the name after the ‘.’).    When
applications are installed, they register the types of files that they can open.    Additional 
associations can be set up by attempting to open a file with Windows Explorer, and selecting
an application from the Open With panel that appears.



Access denied

You do not have permission to access this file.    Check the ownership and permissions of the 
file.



Can’t open file

An error has occurred which prevents the file from being opened.    This could be due to 
there being a problem with the application associated with this type of file.

Alternatively, you could be low on memory.    Close some applications and try again.



Protected files

You have attempted to delete a file that is in the folder where Windows stores files that are 
needed to run the operating system.    Unless you know what you are doing, you are advised 
not to delete any files in this folder.

If you are sure that you want to delete this file, you need to disable the option that protects 
the Windows files.    This is done from the options menu command.



Disk space / file size

The file browser shows two different sizes for files.    This is due to the fact that when files are
stored on a disk, the amount of disk space used is usually greater than the size of the file.

If you are using the NTFS file system, then it is possible to have a file that takes up less disk 
space than the size of the file.    This can happen if the file is compressed.    To compress a 
file, right click the file icon in Windows NT Explorer, then select Properties from the menu 
that pops up.    Tick the compressed box in the Properties panel and press Apply or OK to 
compress the file.

Disk space is divided into clusters, and each file takes up a whole number of clusters.    The 
cluster size varies depending on the size of the disk and the type of file system.    It can vary 
from as low as 512 bytes, to as much as 32 Kbytes (or even more)!    For example, if the 
cluster size is 8 Kbytes, then even a 1 byte file takes up 8 Kbytes of disk space.

This can have a dramatic effect on the amount of disk space used.    A folder that contains 
1,000 files, each of which is only 1 byte in size, could use up as much as 32 Mbytes if the 
cluster size is 32 Kbytes, instead of less than 1 Kbytes that might be expected.

Obviously, the smaller the cluster size, the better, since less disk space is wasted.    
Unfortunately, the most common type of file system which is called FAT-16 (usually 
abbreviated to just FAT) has large cluster sizes for large disks, as shown in the following 
table.

Disk size Cluster size
128

Mbytes
2,048 bytes

256
Mbytes

4,096 bytes

512
Mbytes

8,192 bytes

1 Gbytes 16,384 bytes
2 Gbytes 32,768 bytes

Note: 2 Gbytes is the largest disk size supported by FAT-16.

To check which type of file system you have, double click on the My Computer icon on your 
desktop.    In the panel that appears, right click on the drive you wish to check, then select 
Properties from the popup menu.    The Properties panel shows you the file system being 
used on that drive.

If you are currently using a FAT file system on a large disk

If you are running Windows NT, you can use an alternative file system called NTFS.    This 
also has the advantage of being a more robust file system than FAT.

If you have a PC that was bought after 1996, it may have a newer version of Windows 95 
called OSR 2 (this stands for OEM Service Release).    This version of Windows 95 is only 
available with new PCs, it can not be bought separately.    This version of Windows 95 
supports a new type of file system called FAT-32.    This has much smaller cluster sizes than 
FAT-16 on large disks, and also supports larger disks that FAT-16.    Windows 98 also supports 
FAT-32.

If you have a version of Windows 95 that does not supports FAT-32, or if you want to carry on



using FAT-16 for some other reason, then one solution is to use smaller partition sizes.    The 
description above simplifies things a little, since it assumes that a disk has only one file 
system filling the whole disk.    However, a disk can be divided into sections called partitions,
each of which has a separate file system in it.    As you can see from the table above, the 
smaller the partition size, the smaller the cluster size.    Dividing a 2 Gbyte disk into four 512 
Mbyte partitions will generally allow more data to be stored on the disk, although you will 
have the disadvantage that is has to be spread over four partitions.    These would appear as
four drive letters, such as C:, D:, E: and F:.

If you are using Windows 95, then another thing you can do to get more capacity from your 
disk is to enable compression.    See the Windows Help article referred to in this section for 
more information.



File menu commands

The File menu offers the following commands:

Delete Deletes the selected file(s) or folder(s).
Delete Duplicates Deletes duplicate files.
Scan Size Only When checked, disables scanning for duplicates.
Stop Scanning Stops scanning currently in progress.
Reset Clears all folder size and duplicate file data.
Exit Exits SpaceMan 98.

View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Show Size As Popup menu that allows the units used to show sizes to be 
customized.

Options Brings up the Options panel

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help Topics Offers you an index to topics on which you can get help.
About SpaceMan 
98

Displays the version number of this application, and whether 
it is registered or not.

Exit command (File menu)

Use this command to end your SpaceMan 98 session.    You can also use the Close command 
on the application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in SpaceMan 98.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in SpaceMan 98,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Enable searching for duplicate files.

Disable searching for duplicates, scan folders for file sizes only.

Stop scanning folders.

Clears all folder sizes and the duplicate files list.

Bring up the About box.

Bring up the context sensitive help cursor.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button. A check mark appears 
next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the SpaceMan 98 window.    To display or hide 
the status bar, use the Status Bar command in the View menu.

The status bar describes actions of menu items as you use the arrow keys to navigate 
through menus.    This area similarly shows messages that describe the actions of toolbar 
buttons as you depress them, before releasing them.    If after viewing the description of the 
toolbar button command you wish not to execute the command, then release the mouse 
button while the pointer is off the toolbar button.

The status bar also shows which folder is being scanned when SpaceMan 98 is getting folder
size or duplicate file information.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
SpaceMan 98.    If you have not yet registered your copy of SpaceMan 98, this will also 
display how many days you have left before your evaluation period expires.

Shortcut
Keys: ALT, H, A



Context Help command 

Use the Context Help command to obtain help on some portion of SpaceMan 98.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the SpaceMan 98 window, such as another Toolbar
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the panes in the main window, when the 
contents of a pane are too large to fit.    The scroll boxes inside the scroll bars indicate your 
vertical and horizontal location in the view.    You can use the mouse to scroll to other parts 
of the view.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the SpaceMan 98 window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    SpaceMan 98 determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    SpaceMan 98 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the application or a dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: ALT+F4 closes the application or a dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.




